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Thanks to a poll that Linus Torvalds ran on Google+,
the next version of the Linux kernel will be renamed
from 3.20 to 4.0. According to Torvalds, it’s little
more than wanting to keep version numbers low,
and that 4.0 will simply be “more of the same.”
Currently, PCLinuxOS has 3.18.x as the highest
version of the Linux kernel.

So, on February 23, 2015, Torvalds released the
Linux 4.0-rc1 kernel on Git. In typical Torvalds form,
he had some commentary about the poll process in
his commit message. And, he was in rare form.

.. after extensive statistical analysis of my G+ polling, I've
come to the inescapable conclusion that internet polls are
bad.

Big surprise.

But "Hurr durr I'ma sheep" trounced "I like online polls"
by a 62-to-38% margin, in a poll that people weren't even
supposed to participate in. Who can argue with solid
numbers like that? 5,796 votes from people who can't
even follow the most basic directions?

In contrast, "v4.0" beat out "v3.20" by a slimmer margin
of 56-to-44%, but with a total of 29,110 votes right now.

Now, arguably, that vote spread is only about 3,200 votes,
which is less than the almost six thousand votes that the
"please ignore" poll got, so it could be considered noise.
But hey, I asked, so I'll honor the votes.

So, the 4.0 kernel will be called “Hurr durr I’ma
sheep,” in obvious reference to the 5,796 individuals
who participated in a “poll” that they weren’t
supposed to participate in. I told you he was in rare
form.

In “breaking news” (at the time this column was
written), the U.S. FCC (Federal Communications
Commission) has put into place strict and rigid rules
that prohibit corporate control of the internet in the
U.S. Effectively, it eliminates the possibility of the
creation of internet “fast lanes,” where those who

can pay the bounty … ransom … er, premium … can
get preferential speeds, while everyone else is
relegated to slower speeds. It also prevents ISPs
from giving preference to one type/source of data
over another type/source of data, effectively known
as “throttling.” Thus, torrent data and web browsing
data are treated the same. This is a HUGE win for
internet users across the globe. Since many internet
services are hosted in the U.S., users from around
the globe will have unfettered and unrestricted
access to all of it.

Closer to home for all PCLinuxOS users, Texstar has
updated the Xorg Server to version 1.16.4. If you
have an older nVidia video card, you may have to
change video drivers to work with the new Xorg
Server. You can find a complete discussion here.
The Intel Mesa drivers have also been updated.

Thankfully, Smileeb has had some response to his
pleas for PCLinuxOS users to submit their
information and story for the PCLinuxOS Family
Member Spotlight column. Please, even if you think
no one would be interested in learning more about
you, I urge you to participate. Send Smileeb a PM in
the forum. He will return your query with specific
information on how to be featured in the monthly
column. I’d certainly hate to see this regular column
go away, just because forum members didn’t think
they were interesting enough to their PCLinuxOS
family. The PCLinuxOS forum really is a family, and
we’re all eager to get to know more about our fellow
forum/family members. Plus, we have a tremendous
amount of diversity among forum/family members. It
would be nice to highlight that diversity.

Until next month, I bid you peace, happiness,
serenity and prosperity.

Welcome From The Chief Editor

http://www.pclinuxos.com/forum/index.php/topic,130843.0.html
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by Paul Arnote (parnote)

Adobe Flash. What a scourge on computer users.
Thanks to Adobe, the creators of Flash, it remains
one of the largest security vulnerabilities on
anyone’s computer. Horrid tales of code jumble are
legendary, so much so that there are reports that the
code is impossible for any programmer to follow.
Certainly, this adds to Flash’s security issues.
Couple that with Adobe’s steadfast refusal to open
source Flash (as if they make any money off of it,
anyway), this nefarious plugin has made just about
every computer user gain new gray hairs and curse
its existence.

Most computer users can’t wait for the death of
Flash, and for it to vanish from the computing
landscape. I am among those users. With the arrival
of HTML5, Flash’s days appear to be numbered, and

Adobe will be relegated to – at best – a minor, bit
player with regards to streaming online content. For
me, as well as a lot of other consumers of streaming
online content, that day cannot come fast enough or
soon enough.

So, for the time being, we are stuck with Flash to
play certain streaming online content. But the
numbers are shrinking for sites and files that require
Flash, as HTML5 gains an ever increasing beach
head in the war.

It’s because of the ever increasing security
vulnerabilities of Flash that we have to endure an
almost weekly update of the Flash player plugin. It
seems like every week, some hacker discovers yet
another new way to exploit yet another security hole
in Flash. Since Flash is now (essentially) embedded
in Google Chrome, every new security vulnerability
that is fixed necessitates yet another update of
Google Chrome. Since Adobe stopped officially
supporting Linux, I’m not too sure from where the
Flash player plugin for the Linux version of Firefox
actually comes. But show up it does. And frequently.

Sure, I could just switch to using Google Chrome as
my everyday web browser. But I don’t like Google
Chrome as well as I like Firefox. I’ve been a Firefox
user ever since it was released, and I’ve grown
comfortable and familiar with how it works. I have a
bevy of plugins and extensions that I use with
Firefox, and they are integral with how I’ve come to
work with Firefox. Chrome doesn’t have the same
“feel” for me. It certainly doesn’t “feel” like home.
Plus, a lot of the plugins and added functionality that
I’ve come to depend on in Firefox just aren’t
available under Chrome, they don’t function the
same way, or some of their functionality is lost.

When I see the image above, I know that Flash has
been updated … again. So how does Firefox know
to “flag” your version of Flash as vulnerable? The
answer lies in some new policies and files that are
maintained by Firefox.

Starting with version 2.0, Firefox has had settings
that allow for the blocking of malicious plugins.
Around version 18 or 19, Firefox also added the
ability to block vulnerable plugins. By default, Firefox
downloads a new “blocklist.xml” file daily. Firefox
keeps track of the time by monitoring how many
seconds has elapsed since the last daily file update.
So, 24 hours equals 86,400 seconds. When 86,400
seconds have elapsed since the last blocklist.xml file
download, Firefox downloads a new one. So, that is
how Firefox knows whether or not your plugins and
extensions are “up to snuff.”

In the case of Flash, the annoying message above is
displayed on every single website you view that
uses Flash. You will have to “Allow” the “outdated”
plugin to run on every single site that you visit …
and this gets old, fast. Obviously, the ideal solution is
to run updates on your copy of PCLinuxOS. But, if

Gain Control Of Firefox
"Flash Is Out Of Date" Message
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you’re not in a position where you can run updates
at that moment, or if you typically only run updates
weekly or bi-weekly, then one of the following
solutions may be more to your liking.

Go ahead and type “about:config” in Firefox’s
address bar. Click on the “I’ll be careful, I promise!”
button (and please … do be careful). Next, type
“extensions.block” on the Search line. You should
see several entries listed. They are, with the default
values in parenthesis:

extensions.blocklist.detailsURL
(https://www.mozilla.org/%LOCALE%/blocklist/)

extensions.blocklist.enabled
(true)

extensions.blocklist.interval
(86400)

extensions.blocklist.itemURL
(https://blocklist.addons.mozilla.org/%LOCALE%/%A
PP%/blocked/%blockID%)

extensions.blocklist.level
(2)

extensions.blocklist.pingCountTotal
(user set)

extensions.blocklist.pingCountVersion
(user set)

extensions.blocklist.url
(https://blocklist.addons.mozilla.org/blocklist/3/%APP
_ID%/%APP_VERSION%/%PRODUCT%/%BUILD_
ID%/%BUILD_TARGET%/%LOCALE%/%CHANNEL
%/%OS_VERSION%/%DISTRIBUTION%/%DISTRI
BUTION_VERSION%/%PING_COUNT%/%TOTAL_
PING_COUNT%/%DAYS_SINCE_LAST_PING%/)

You *could* just disable the blocklist entirely. You
*could* set “extensions.blocklist.enabled” setting to
“false,” or you could change the
“extensions.blocklist.url” setting to “” (or NULL). But I
wouldn’t recommend doing either. By doing so, you
prevent Firefox from blocking not only extensions
and plugins with vulnerabilities, but you also prevent
Firefox from blocking malicious plugins. In short, you
could be inviting all kinds of (in)security issues upon
yourself. So, this is probably not the best way to go.

You could change how often Firefox downloads the
blocklist.xml file. Since the default is 24 hours, or
86,400 seconds, we could change the interval to
something longer. Here are some other intervals you
might be interested in:

Week (7 days): 604800
2 Weeks (14 days): 1209600
Month (30 days): 2592000

Another choice could be to change the blocklist
level. The “extensions.blocklist.level” is set to “2” by
default, which means to “hardblock” extensions

Full Monty ... Everything you might want or need –
plus the kitchen sink!

Gain Control Of Firefox "Flash Is Out Of Date" Message

http://www.pclinuxos.com/?page_id=1413
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listed in the blocklist.xml file. By “hardblocking” the
extensions, they will not be run unless there is user
intervention telling Firefox to go ahead and run/use
that extension. Changing the level to “1” should
change the blocking level to “softblock.” This tells
Firefox that the item is in the blocklist, but the
problem is not severe enough to warrant forcible
blocking.

Still another choice could be to simply delete the
blocklist.xml file from your computer (on my
computer, it’s located at /home/parnote-
toshiba/.mozilla/firefox/pwgl1kmj.default/
blocklist.xml). This is useful only until Firefox
downloads another copy when 86,400 seconds is
up. Still, it can eliminate the nagging about a
vulnerable plugin or extension for a little while.

Summary

No one will disagree that Flash is something that
most, if not all, of us can’t wait to see go away. No
one will disagree that Flash is one of the largest
security vulnerabilities on the internet, and possibly
of all time. Most people will concede these
arguments, and agree with you. But since we’re
strapped with this albatross for the foreseeable
future, it would be nice to not have to put up with the
constant nagging from Mozilla about yet another
vulnerability that has been discovered, which is
every time that Adobe issues another update. These
days, it seems they only update Flash when another
security vulnerability is discovered, and that’s
proving to be quite often lately.

By all means, keep your PCLinuxOS installation
updated regularly. It’s the best defense against those
security vulnerabilities. But the methods discussed
above can keep things running well until you can get
around to performing those updates, and help keep
the nagging from Mozilla to a minimum.

Screenshot ShowcaseScreenshot Showcase

Posted by Rok4Fun, on February 1, 2015, running KDE.

Gain Control Of Firefox "Flash Is Out Of Date" Message

http://pclostalk.pclosusers.com
http://www.fsf.org
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As Told To Smileeb

Here is Xenaflux

How old are you?

I will be 70 this coming June.

Married, single or what?

I am married for nearly 25 years now. This is my
second marriage.

Children, grandchildren?

Yes, I have three children (with my first wife). One
daughter and two sons. They are 50, 48 and 46.

I also have three grandchildren. The first one, a boy
and 22 now, with my daughter. The next two, a boy

and a girl (ten and four years old) with my youngest
son (below).

Retired or working and for how long and at
what?

I am officially retired, but carry on working, mainly
teaching Thai children (privately) what to do with the
knowledge they have picked up in school (as the
success rate in school is no more than 15% to 20%;
it is all theory and no practice).

Up to two years ago, I was still involved in
electronics (occasionally) and home computers
(regularly). I stopped that, because it was getting too
tiring.

What is the area you live in like. Weather,
Quietness, Scenery?

I live North-East of Bangkok, about 60 Km away
from the capital. The weather is on the hot side for
most people. Temperatures inside the house are 25
to 30 degrees in the cold season, and up to 32 to 36
degrees inside the house in the hot season (all
midday measurements). Of course, when the wind
blows, or the fans are on, we can get more
comfortable. If you can afford the electricity bill, air
conditioners are the answer!

As I live now on the end of a two Km long street with
only one in/out point, it's very quiet, except when the
56 dogs in this street who seem to have formed a
Union, have a concert every now and then. Their
favorite concert time is about 1:00 AM.

PCLinuxOS Family Member Spotlight: Xenaflux
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As far as scenery is concerned, it's not around
Bangkok. It’s up North and to the coast....yes!

Are you handy with your hands and have any
hobbies?

Yes, I always have been good with my hands, since
childhood! Only when heavy machinery is (was)
involved, I will (would) call for help. Building a small
room, plumbing and that sort of thing I always have
done myself. My hobbies have changed from
reading and sports to playing the Keyboard (organ).
My favorite hobby at the moment is "avoiding
sweat."

What is your education level?

I graduated from Technical High school as a
Technician in Electronics (no specialization), and got
Certificates of "This and That" during my adult
working life. I was granted an Engineer's Diploma at
the age of 44.

Do you like to travel, go camping?

Not anymore. When I was younger, I visited
countries in South America every second year for 2
months, and in between, countries in the south of
Africa (I lived that time in Johannesburg, South
Africa)

What caused you to try Linux and join this
forum?

Some ten years ago, I was using XP, just like a lot of
people here. The problem was that I was
running/maintaining three or four computers daily.
One day, I worked out that over a year I spent about
150 hours on only maintenance/fixing. I decided to
try Ubuntu, as they sent the CDs free of charge to
your postbox. That was then still a rocky road.

I changed to Mandrake and that was better. There at
Mandrake was a packager called Texstar, which
seemed to have a certain popularity among the
members. (I wonder why?) When Tex made his first
distro, I tried it and .....the rest is history. I never got
involved in Distro-hopping, except on VMs every
now and then.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your interest.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

DOWNLOAD

Mate Desktop

PCLinuxOS Family Member Spotlight: Xenaflux

http://www.linuxfoundation.org/
http://pclinuxos.com/?page_id=188
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://www.linfx.com
http://pclosmag.com/html/sorted.html
http://www.fsf.org
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by John Gagne (zerocool)

(Note: This article uses KDE, but it should be easily
adapted for use under other DEs.)

My son is a 1st Lieutenant in the US Army. He was
issued a smart ID card and reader which allows him
to logon to secure sites. I thought that was pretty
cool! The coolest thing I had on my military ID card
was a QR code. I’ve seen other “smart cards,” both
chip and RFID, thumb drive keys, fingerprint
scanners, even face recognition all used for access
identification and unlocking privileged computing
resources of some kind or another. But it was seeing
my son’s smart card that got me thinking how to
automatically unlock my screen with (what else) my
cell phone. Needless to say, I wanted my solution to
be even cooler than my son’s ID card. And in my
humble and totally unbiased opinion, this is way
cooler.

Basically, the script pings your local network for your
smart phone’s IP address and if it’s found, unlocks
the screen. If it’s not found, it locks the screen,
instead.

So, why a cell phone? It seems an obvious choice.
We all have one and we keep them with us all the
time. Where we go, so do our phones. Our phones
have become ubiquitous with our immediate
presence or absence, and smart enough to make
that presence or absence “detectable.” When I
searched, I found an android app that accomplishes
the unlock via bluetooth. I didn’t try it for several
reasons, not the least of which being that we
generally don’t keep bluetooth on because it kills the
battery. But wifi, on the other hand, we use so much.
It’s always either on or controlled by the device in
sleep mode, but even then it’s always listening for

the access points it knows (home, work,
Starbucks,...) and when these are detected, it
automatically connects. So, all we really have to do
is teach our computers to accomplish this detection
and unlock the screen for us.

So, why use a bash script? Again, It seems an
obvious choice. Besides, practicing a little bash
kung-fu is never a waste of time! It’s extremely
powerful and available on all Linux machines.

First we have to do some simple housekeeping on
our phones. We need to set a static IP address. You
can use any unused address that’s outside the
scope of your DHCP bank. For most standard home
routers, DHCP addresses generally start at
192.168.1.100 and run through at least
192.168.1.150. Generally speaking, any IP between

192.168.1.20 - 192.168.1.90 should be good and if
it’s not – odds are you already know what IP address
to use. Once you have an IP address in mind, follow
this guide to set the static IP address.

For android phones, go to: goo.gl/oMaVvx
For iPhone phones, go to: goo.gl/q1SUTj

Lastly, set your phone’s wifi to “stay on when
charging”. Then when you’re using the computer,
plug the phone in to charge. That way, the wifi won’t
shut off in sleep mode and lock your computer
screen.

Next, let’s perform a little housekeeping on your
computer. Create a folder called bash, and then
inside the bash folder, create another folder called
lock. Then open an editor and copy and paste the
code on the next page.

Edit <user_name> with your user name. In my case
it would look like:

USER=zerocool

Edit <ip_address of your phone> with the static ip
address you set your phone to. In my case it looks
like this:

IP_ADD="192.168.1.17"

Notice it’s inside quotes.

Edit <welcome message> with the system message
to be sent when your phone is detected, in my case
it looks like this:

MESS_TXT=" Welcome Cool "

Unlock Your Computer With Bash & Your Cell Phone

http://goo.gl/oMaVvx
http://goo.gl/q1SUTj
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Again, notice it’s inside quotes and the starting and
ending spaces. Save the file as ~/bash/lock/lock.sh

Next, we want an audible indication of recognition
when the computer detects the presence of our
phone. I created an mp3 file with an online text to
speech engine and then downloaded the file from
here:

http://www.fromtexttospeech.com/

Create your own or you can download mine here:
goo.gl/uDK6Hv

Save the file as ~/bash/lock/welcome_home.mp3.

Last but not least, open your editor again and paste
in the following text:

[Desktop Entry]
Comment[en_US]=
Comment=
Exec=/home/<user_name>/bash/lock/lock.sh&
GenericName[en_US]=
GenericName=
Icon=preferences-desktop-user-password
MimeType=
Name[en_US]=
Name=
Path=/home/<user_name>/bash/lock/
StartupNotify=true
Terminal=false
TerminalOptions=
Type=Application
X-DBUS-ServiceName=

X-DBUS-StartupType=
X-KDE-SubstituteUID=false
X-KDE-Username=

Edit <user_name> and save the file as
~bash/lock/lock.desktop. To manually start the script,
navigate (via CLI or Dolphin) to ~/bash/lock/ and run
lock.desktop. If you want the script to auto start on
boot, then also save the file as
~/.kde4/Autostart/lock.desktop.

While it’s certainly not Fort Knox with respect to
security, if you’re like me and didn’t use a screen
locker at all, this solution is more secure than none.
Besides, it’s kind of cool to walk in and be greeted
by your computer.

#!/bin/bash
mesg y
USER=<user_name>
IP_ADD="<ip_address of your phone>"
MESS_TXT=" <welcome message> "
FLAG=1
LOOP=0

while [ $LOOP -lt 1 ]
do
ping -c 1 $IP_ADD > /dev/null 2>&1
RESULT=$?
if [ $RESULT -lt 1 ] && [ $FLAG -lt 1 ]

then
echo "Welcome $(date)" >> ~/bash/lock/lock.log

qdbus | grep kscreenlocker | sed 's/org.kde.//' | xargs kquitapp > /dev/null 2>&1
echo $MESS_TXT | write $USER
sleep 3
play ~/bash/lock/welcome_home.mp3 > /dev/null 2>&1
FLAG=1

fi
if [ $RESULT -eq 1 ] && [ $FLAG -gt 0 ]

then
echo "Locked $(date)" >> ~/bash/lock/lock.log
qdbus org.freedesktop.ScreenSaver /ScreenSaver Lock
FLAG=0

fi
sleep 10

done

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

Unlock Your Computer With Bash & Your Cell Phone

http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
http://www.fromtexttospeech.com/
http://goo.gl/uDK6Hv
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Created with Scribus

Available in the following desktops:

KDE LXDE Xfce

Openbox Gnome

Enlightenment e17

Posted by OnlyHuman, on February 16, 2015, running e17.

http://www.scribus.net
http://www.linuxforum.com
http://www.pclinuxos.com
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by daiashi

About The Game

“Outwit gravity, race the clock, explore new worlds.”

“Crashed Lander is a gravity-based arcade game
inspired by classics like Lunar Lander and Space
Taxi. You've built a janky craft out of propane tanks
and spare parts. Pilot it from pad to pad trying to
beat your best time – then flirt with that fine line
between speed and control.

If you’re brave enough to try Hard Mode you’ll be
flopping around like a QWOPy, low gravity turtle.
With a little practice you’ll be zippin' around doin'
barrel rolls. You’ll see sites from the cutting edge of
fractal mathematics – bizarre, organic shapes,
arcane archaeological digs, and all manner of
WTFderful alien vistas. Each level is a detailed
hand-crafted landscape that encourages the player
to explore - and goof around! You can also pilot your
lander in virtual reality with your Oculus Rift.”

* 24 levels to conquer and explore in Pad Hopper
mode

* 20 levels in Ring Runner mode - fly through
custom courses

* Pad Hopper, Fuel Miser and Ring Runner high
scores

* Full Oculus Rift support
* Full (xbox 360) controller support
* Hidden collectibles on every level
* Earn stars and track your progress through all

44 levels
* An hour of spacey, glitch-hop music - mp3's

included!

Not a full action packed good guy versus bad guy
game but amusing nevertheless. Hopefully, Don will
be adding more levels in the future. Maybe an
underwater version with environments based on
actual data. It’s nice to see folks with these talents
getting recognized for what they like to do. This is a
great time filler. Have not tried it on a flat screen tv
as of yet, only on my 20”. Should look as equally
good though. Well, back to the game. Hope you
enjoy it.
http://www.brainblinks.com/#/crashed-lander/

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:

Minimum:
OS: PCLinuxOS

Processor: Intel Core i5 or equivalent

Memory: 2 GB RAM

Graphics: NVidia 560ti or equivalent

Hard Drive: 900 MB available space

About The Company

Don Whitaker is a 46 year-old digital tinkerer living in
the Willamette Valley of Oregon, USA. He has been
making things with computers for over 33 years
using every creative tool he can get his hands on.
For the last three years he has been using Unity to
combine various digital design skills into fun,
experimental projects. Don felt like he was ready to
launch a full-time game dev career and Crashed
Lander is Don’s first full-on game.

You can see some of Dons’ other game experiments
over on BrainBlinks website. Widdly Tinks is a one-
finger arcade game, Gravitas is a fun physics toy,
and Breeders is a simulation of artificial life.

Some Gameplay Screenshots

Game Zone: Crashed Lander

http://www.brainblinks.com/#/crashed-lander/
http://www.brainblinks.com/
http://www.brainblinks.com/widdly-tinks/
http://www.brainblinks.com/gravitas/
http://www.brainblinks.com/#/breeders/
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Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the

Linux tab if you wish and search for. Click on and
download the demo. If you have updated your
system, including graphics drivers, you should be
good to go.

http://store.steampowered.com/app/340450/?snr=1_
7_tabpaginated__222

Screenshot ShowcaseScreenshot Showcase

Posted by zerocool, on February 8, 2015, running KDE.

Game Zone: Crashed Lander

http://store.steampowered.com/app/340450/?snr=1_7_tabpaginated__222
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by Khadis

Floral or flourishes designs are almost everywhere:
name cards (both personal and business name
cards), flyers and brochures, banners, or any other
printed advertisement media. Floral designs are
always attracting me because of the shape and the
imagination inside of them. Luckily, I can create any
floral shape easily using Inkscape. Let’s go!

Open up your Inkscape as usual. Prepare your
paper as you desire because the size of the paper
will not matter. Before we really start to draw the
flourishes, basically, there are two methods: complex
and easy. Now, I will show you the first method, the
complex one.

* Using your Ellipse tool (F5), create a circle at any
color for the fill and no stroke. I prefer to create a
small one, only 0.5 cm. See your unit preference on
the toolbar. It used to be in pixel (px). If you wish,
you can change it into centimeter (cm), like mine.

* Copy or duplicate your circle into 3 or 4 circles.
Resize them to be bigger or smaller than the first
one. Please resize the new circles with proper scale,

and don’t resize them too big. Just resize them to be
2 times bigger or a half time smaller. Since the
circles maybe too small, don’t forget to use the
Zoom tool to increase the visibility of your circles.

* Now, to start drawing the floral design, copy the
smallest circle first. Of course, you can choose any
size of your circles for the beginning, but I choose to
use the smallest one.

* Press Ctrl + C to copy the circle. Don’t paste it.

* Activate your Bezier tool (Shift + F6) and use the
parameter as follows:

* Click and drag several times to form your flourish.
Keep repeating your clicking and dragging (click-
drag-click-drag and so on) until you get your desired
flourish shape. The clicking and dragging direction
may be like this (I only drew an ordinary line to
describe the same step using Bezier tool):

* Open up Path Effect Editor (Shift + Ctrl + 7)
window. There, you will see a Width box under the
Pattern Copies drop-down option. You can change
the value to meet your need. You can also use the
Edit path by nodes (F2) tool to reshape your
flourish by clicking and dragging the nodes.

* Create another shape using your bigger prepared
circles to see the different results. You can try to use
other basic shapes too, such as rectangle, triangle,
or star shape to get more funky result.

* Create several objects with different size and
Bezier direction. You can copy or duplicate the same
object and then resize it. Then, put your creations
into a combined shape. You can arrange them to be
close each other by rotating, mirroring, or resizing
them. Your final result may be better than mine:

Inkscape Tutorial: Creating A Floral Design
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That is the first method. The second method will be
much easier because you do not need to prepare
any shape, but directly draw your flourish using the
Bezier tool.

* Activate your Bezier tool (Shift + F6) again.
Change the Shape option into “Triangle In”.

Note: If you are using the newest version of
Inkscape, you may change the “Triangle In” into
“Ellipse” mode in order to activate Path Effects with
the editable Width parameter. If you don’t use
“Ellipse” mode, the path effects window may appear
like this:

Start drawing your flourish with the same steps as
previous method. Click and drag the Bezier tool to
make a base shape of your floral.

(do “sketching” like this again)

Make some adjustments to fit your need by using
Edit path by nodes (F2) tool. You can also increase
or decrease the shape width through Path Effect
Editor (Shift + Ctrl + 7) window.

Create some floral shapes and combine them like on
the previous method.

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

Inkscape Tutorial: Creating A Floral Design

http://www.cafepress.com/pclinuxos
http://www.pclinuxos.com
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by Paul Arnote (parnote)

Time. It’s at the core of nearly everything we do. Our
lives center around it. Our lives are defined and
dominated by it. We use time to measure nearly
everything. Our work week. How fast our computers
boot. When to eat. When to sleep. When to wake.
When to go to work. When to take a break. Birth.
Death.

With something so integral to our existence, it’s no
wonder that there are people whose job it is to fret,
worry over, “manage,” and monitor time. They are
the planet’s “timekeepers,” if you will. If you’re like
me, you may think that these individuals have way
too much of what they are given stewardship over.

Since 1972, they have periodically been inserting
“leap seconds” to our clock to “compensate” for
irregularities in the Earth’s orbit. These
“irregularities” render the atomic clocks “too
accurate,” and astronomical time (based on the
Earth’s orbit, with all of its irregularities) and “atomic
time” will no longer perfectly sync up. In an
oversimplified way, UTC time (also known as
Coordinated Universal Time) relies on the time as
reported by the atomic clocks. Believe me … this
whole time business is complicated. You can find a
reasonable, albeit complex, explanation here. Be
prepared to jump around on that site to get a
complete picture of all the complexities involved.

Herein lies the problem. The leap second is added to
prevent the eventual drifting of GMT (Greenwich
Mean Time) westward, according to the atomic
clocks. Many computer systems – including Linux –
synchronize their clocks with UTC time. To be fair,
Linux synchronizes its clock with NTP (Network Time
Protocol), which utilizes UTC time.

I don’t know about you, but I hardly see this as a
crisis, or even a problem that needs to be fixed. The
Earth has been here for over 4,540,000,000 years
(yes, BILLION), complete with all of its orbital
irregularities. The fact that our atomic clocks are too
accurate hardly seems cause for disturbing
something that has been going on since the Big
Bang: time, as we have come to know it. Sunrises
occur every morning, sunsets occur every evening.
In fact, it was never a problem until we – mankind –
came up with a timepiece (atomic clocks) that did
not take into account the irregularities of the Earth’s
orbit. So, in a way, WE manufactured this problem.

This coming June 30, they will once again add
another “leap second” to the official clock. At
midnight on June 30, the leap second will be added
right after 11:59:59 (p.m.). During that brief second,
the clock will read 11:59:60, as they add the
additional second to the clock. This will mark the
11th time that a leap second has been added on

June 30, since 1972. This joins the 15 times that a
leap second has been added on December 31, for a
total of 26 leap seconds that have been added to our
clocks since 1972. In fact, a leap second is added to
UTC time on average of every 18 months, give or
take (depending on those orbital irregularities of
Earth).

Sounds like a fairly simple proposition, huh? But wait
… there’s more.

Back in June 2012, the addition of the leap second
brought many popular websites down. We’re talking
about sites like Reddit, Amazon Cloud, Gawker
Media, and Mozilla, among others. A “glitch” in the
Linux kernel was the cause. More specifically, the
Linux kernel has a function/subsystem called
“hrtimer,” short for high resolution timer. It (or
programs that have a strong reliance on hrtimer)
simply couldn’t handle the addition of the leap
second, causing it to consume large amounts of
CPU time as it tried to reconcile the time difference.
In the end, so much CPU time was consumed that it
effectively locked those computers up. The problem
was resolved simply by rebooting the affected
machines.

While the average user probably hardly noticed, it
affected many servers running Linux. See, Linux –
more specifically hrtimer – syncs via NTP, which
utilizes UTC time. The discrepancy between hrtimer
and UTC time was more than it, or programs that
depend on hrtimer, could handle. The “glitch” had
been patched in March 2012, but not everyone had
applied the update. Those who hadn’t were the ones
adversely affected.

So, what’s in store for the June 2015 leap second?
Well, according to Linus Torvalds, it shouldn’t be
anything to worry about. In the intervening three

Tic, Toc, Tic, Toc ... It's About Time

http://www.timeanddate.com/time/international-atomic-time.html
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years since the last leap second, most if not all of
the servers have updated their kernel and kernel
subsystems. Additionally, a lot of the software that
depends on NTP/UTC has also been updated.
Torvalds expects the problems to be minimal, and
expects nothing even remotely close to the problems
experienced in June 2012.

Still, someone, somewhere is bound to experience a
problem. According to Torvalds, the leap second is a
rare and infrequent event. While the testers may test
under one set of circumstances, there’s no
guarantee that a new circumstance that was not
previously thought of won’t crop up. And, because
the addition of a leap second is such a rare and
infrequent event, it’s not something that kernel
testers routinely check.

Tic, toc, tic, toc … it’s ALL about time.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by tbschommer, on February 14, 2015, running KDE.

Tic, Toc, Tic, Toc ... It's About Time

http://www.pclosusers.com/services-signup.php
http://www.pclinuxos.com/?page_id=10
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When I had a Windows problem PCLOS came to me
Speaking words of wisdom Download Me

And when I had an error message PCLOS came to me
Speaking words of wisdom Download Me

Download Me Download Me Download Me Download Me
Linux is the answer Download Me

When I could not find a file although I looked a long long while
There was the answer Download Me

And when those updates started coming and my nose I started thumbing
I now know the answer Download Me

Download Me Download Me Download Me Download Me
Linux is the answer Download Me

When my drivers were a weaving and with Windows I was grieving
There was the answer Download Me

When I had to start in safe mode 'cause my 'puter overflowed
I heard those words of wisdom Download Me

Download Me Download Me Download Me Download Me
Linux is the answer Download MeMP3 OGG

ms_meme's Nook: Download Me

http://pclosmag.com/html/Issues/201503/files/downloadme.mp3
http://pclosmag.com/html/Issues/201503/files/downloadme.ogg
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This month's recipe comes from the PCLinuxOS
forum user Ramchu.

INGREDIENTS:

2 Tbsp Cornstarch
2 Tbsp Cold Water
3/4 Cup White Granulated Sugar
1/2 Cup Soy Sauce
3 Tbsp Cider Vinegar
1 Tsp Garlic Powder
1/2 Tsp Ground Ginger
1/2 Tsp Ground Black Pepper
10 Chicken Thighs or 6 Chicken Breasts

DIRECTIONS:

1. In a small saucepan over low heat, combine the
cornstarch, cold water, sugar, soy sauce, vinegar,
garlic, ginger and black pepper. Let simmer, stirring
frequently, until sauce thickens and bubbles.

2. Preheat oven to 425 degrees F (220 degrees C).

3. Place chicken pieces in a lightly greased 9x13
inch baking dish. Brush chicken with the sauce. Turn
pieces over and brush again.

4. Bake in the preheated oven for 30 minutes. Turn
pieces over, and bake for another 30 minutes, until
no longer pink and juices run clear. Brush with sauce
every 10 minutes during cooking.

Visit Us On IRC
• Launch your favorite IRC Chat Client software

(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"

(without the quotes)

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

PCLinuxOS Recipe Corner

Baked Teriyaki Chicken

http://www.linuxforums.org/forum/
mailto:pclinuxos.mag@gmail.com
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Screenshot ShowcaseScreenshot Showcase

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by Hertz, on February 3, 2015, running LXDE.

http://pclinuxos.com/?page_id=7
http://www.opensource.org/
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
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u
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o
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n
s

H
er

e

Possible score 200, average score 140.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201503/files/2015-03-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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1. Wild game or birds.
2. Saddle makers do this.
3. China can be made or collected.
4. Ballroom, ballet, or even modern.
5. Paper folding.
6. Sewing designs onto an object.
7. Building furniture.
8. I love a good adventure story.
9. Get all your momentos organized

in one spot.
10. Like knitting, and many items can

be created.
11. Some of these works hang in museums.
12. Fancy writing design.
13. Karaoke, anyone?
14. You can use a computer or other device

for this.
15. Exercise for relaxation and meditation.
16. Many people create bracelets

or necklaces.
17. Stuffing and displaying an animal.
18. The same activity you are working

on now.
19. Throwing items in the air.
20. Some guys have miniature cars.

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: March 2015
Hobbies

http://pclosmag.com/html/Issues/201503/files/2015-03-PuzzleSolutions.pdf
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Calligraphy
Ceramics
Computers
Crocheting
Dancing
Embroidery
Fishing
Gaming
Hunting
Jewelry Making
Juggling
Knitting
Leather Crafting
Model Building
Origami
Painting
Puzzles
Quilting
Reading
Scrapbooking
Sculpting
Sewing
Singing
Sports
Stamps
Taxidermy
Woodworking
Writing
Yoga

Download Puzzle Solutions Here

P U W O O D W O R K I N G M Q B P S H M Z G P Y G J S C E R
U L G X Q V W C W B H T Y P Y W M U R I T R O G N Q S U W M
K U B P S V T D F J L P U B L L K D U E C F W U I W O Y G W
C K C A V S C W B T Y Q K M V M Y A J R T D E E T T Y F X L
P B A X O C N W E X K O L P T P V D S N C U A D E Z O G P W
S P M A T S T X D N O A Q A X M R C M Z C C P N H S B S X W
N Y D Q S G J O Q F A S O K X U F Q J U H S Q M C B C G P C
I O R U K H D P J R M H C A L L I G R A P H Y R O I J P F E
O V U C L O Q O Z P O K J W G K X Z C B Z W A R R C N J N V
W K C D M S O F D P A S P G N I T L I U Q P A J C H E G E G
W S E L Z Z U P M J L Y H H D T F N G P B D A P W M B N N K
M R A F F I L E T O N R B R O G A U Q O V P G A O Q V I B R
D T I O F C R U N W X Q P A W E N P O U H V O I R L T D Q E
N I U T W L H T T Z I M O A S F H K J N Q M Y F W N R L G N
J G E G I U E R K A S W Q J T A I N C Y O F I G I S C I M L
H N T Y N N S G V C X C M R S N N Y W R R T N A H N B U B P
Z I F T M J G E M M C I U R G E H Q L J R S P S U Q F B Q P
D G I F L O U C A H D Z D L W S M D L T F T N L C S H L V D
J N L E K Q R R B F M F H E P G L B O L Y P Q A U M W E K X
G I O P Z G Q O J X V I W G R T F N R D P W L E Q O R D X O
V S F C Y B J L N B V C E R A M I C S O T F P N K Q J O C T
J J C J W T N Z F G D W A U D F Y N D D I J S N G K P M Q E
S V V C L E A T H E R C R A F T I N G U L D I N J L B C D L
L G N I K A M Y R L E W E J W V S S X D G T E N H M J J H H
S K Q M G V G N I W E S Q F T Z C N H T T B R R Q F G U U I
X P A M U S X B W N A W V C D F U G N I D A E R Y F I Y G G
Z Y O P R V F W H G Y U D I T G L O N R N X M L G G I N K S
D J C R N U A J H C F Y F O O R I G A M I G O Y X Y V G W K
B U C V T I X E M S M Z S L H H L U V X W V G Z Q Y O S I Z
L V R G X S N G A M I N G N I L G G U J Z C I G D Y E P L C

PCLinuxOS Puzzled Partitions

Hobbies Word Find

http://pclosmag.com/html/Issues/201503/files/2015-03-PuzzleSolutions.pdf
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by Meemaw

We’ve done backgrounds before, but we will use
GIMP this time to create a swirled background. This
was a fun tutorial to do, as well.

Open a new image (File > New) in the size you
want. I used 1600 x 1200, but you can use bigger if
you need it.

Decide on a color and then choose two shades of
that color so we can put in a bit of a gradient. My
favorite wallpaper color is blue so I used two
different shades of blue.

Click on the Blend tool in the Toolbox and verify that
the Gradient is set to FG to BG and the Shape set
to Linear. With the Blend tool, draw a line from the
top to bottom, bottom to top, or from corner to
corner. I drew mine from top left to bottom right, and
as you can see, the top left corner is darker.

Change the foreground to white, then draw a swirl in
the middle of your image using the brush tool. The

the swirl won't be perfectly uniform, unless you draw
much better than I do!

Click on Filters > Blur > Gaussian Blur and set
both values to 40, then click OK. You should have an
image that looks sort of like this:

Now, click on Filters > Distorts > Whirl and Pinch.
Move the Whirl angle slider all the way to the right
(the number will be 720), the Pinch amount slider
about three-quarters to the left (around -0.5) and
leave the radius at 1.00.

Let’s adjust. Click Filters > Distorts > Waves. Make
sure that the Smear radio button is selected. Play
around with the amplitude, phase, and wavelength
sliders until you're happy with the result (as you can

GIMP Tutorial: Create A Swirl Effect



PCLinuxOS Magazine Page 25

see on the previous page, I set the amplitude to 70,
phase to 145, and wavelength to 45).

Before we finish, we want to make the ripple effect
stand out a bit more. Go to Filters > Artistic >
Softglow and adjust the sliders to your liking. I set
the Glow radius to 1.00 (all the way to the left),
Brightness to 0.25, and Sharpness to 1.00 (all the
way to the right).

We are finished, unless you want to go back and
adjust something else. You can always go back into
any of the Filters items and change settings. If you
decide the color is wrong, instead of starting over,
click on Colors > Hue-Saturation and adjust the
Hue slider.

You can always play around with the other filters and
see what different effects you can come up with.
One option is Filters > Render > Clouds >
Difference-Clouds. I changed the color of my
original to a shade of green (in Colors > Hue-
Saturation), then did the Difference-Clouds filter
with the X and Y sizes set to 1. ------->

Experiment all you want!

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS Magazine

Created with Scribus

Posted by nymira, on February 23, 2015, running Mate.

GIMP Tutorial: Create A Swirl Effect

http://www.scribus.net
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Posted by Aleph, on February 1, 2015, running icewm.

Posted by Yankee, on February 9, 2015, running Openbox.Posted by Meemaw, on February 12, 2015, running Xfce.

Posted by weirdwolf, on February 8, 2015, running LXDE.

More Screenshot Showcase




